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SS Yongala (1911) Shipwreck, Great Barrier Reef. GIRT Survey 24 November 2020.
Photographer: Andrew Viduka.



8. METADATA GUIDANCE 
Metadata (a set of data that describes and gives information about other data) recommendations are aligned 
with a diver’s standard equipment and use of a camera underwater. All values are recorded in a particular 
manner to ensure consistency, repeatability, robustness of method and to facilitate comparative analysis. Before 
diving, cameras need to be set for the correct date and time. Images can be collected in JPEG format, however 
if divers wish to use the RAW or TIFF/JPEG option. Please note that this may reduce shutter speed when doing 
photogrammetry.

8.1. GIRT SURVEY SHEETS

8.1.1. Site Identification Sheet Example

Data to be Collected Metadata Description

Site – Name and year of 
sinking

i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their 
registered or historically correct name)

Statutory database number AUCHD Shipwreck ID number
(https://dmzapp17p.ris.environment.gov.au/shipwreck/public/wreck/ search.do)

Which statutory database? Dropdown option list auto populated with AUCHD. Needs a chance to type in a database 
name in another field

Number of surveys conducted 
at this site

Number of surveys already completed by you at the site

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Date of survey Format yyyymmdd (i.e. 20180728)

Time of survey Format 00:00 24 hour

Location (Latitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Location (Longitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234. Members are required to enter the location data in Degrees 
and Decimal Minutes format)

Approximate location position 
recorded at

Select one: Stern, Amidships, Bow

Datum i.e. WGS84, other (free text field) datum

Position format Select one: Degrees and Decimal minutes (GIS), Decimal Degrees (GPS), Degrees, Minutes 
and Seconds (Charts)

Distance from Land/Reef Select one: 0 - 1 nautical mile (nm), 1 -3 nm, 3 - 5 nm, 5 - 10 nm, > 10 nm

Current at surface (speed) Surface sheet – “(1 knot = 1.85 km per hour)” or (1 knot = 30.1 metres per minutes)” 
Ropes and lines are used by divers for various purposes including to determine the speed 
of a tidal flow. For example, if a 30-metre line fully extends to its full length in a minute, 
the speed of tidal flow would be about one knot

Current at surface (direction) Record compass direction North, North East, East, South East, South, South West, West, 
North West (i.e. Easterly current). (NB. The direction of ocean currents is the direction 
they’re headed for or where the current is flowing towards, and the direction of wind is 
named as the direction from where it’s blowing. So an easterly current and westerly wind is 
going the same way or has the same vector - from west to east)

Tide at survey Select one: High tide, Low tide, Ebb tide, Flood tide

Freshwater/Saltwater influ-
ence

Select one: Yes - River, Yes - Spring, Yes - Run Off, Yes - Sea Water, No (The preserva-
tion of sites can be influenced by a change in the salinity which can impact biological and 
chemical deterioration. Potential freshwater influence on your site should be noted)

Sediment plume visible in 
water

Select one: Yes or No. (Generally in tropical environments, large rainfalls cause significant 
sediment to be washed out to sea, this happens near SS Yongala in North Queensland. 
Generally the water is dirty with a very low visibility)
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Data to be Collected Metadata Description

Sea state Select one: 0 metres = Calm (glassy), 0 to 0.1 metres = Calm (rippled), 0.1 to 0.5 metres = 
Smooth (wavelets), 0.5 to 1.25 metres = Slight, 1.25 to 2.5 metres = Moderate, 2.5 to 4.0 
Rough (General condition of the surface of the water with respect to wind, waves and swell 
at a certain location and moment. Use the World meteorological Organizations sea state 
code)

Swell height Select one: 0-No swell, 1- Very Low, 2 - Low, 3-Light, 4-Moderate, 5-Moderate rough

Site classification Select one: Class 1, Class 2, Class 3, Class 4, Class 5, Class 6 (Based on Muckelroy. Refer 
back of Surface sheet for guidance)

Debris zone pattern Select one: Pattern A, Pattern B, Pattern C, Other (from Warren 2016). (Most shipwrecks 
end up with a debris field associated either with the wrecking event or subsequent post 
depositional actions. If artefacts are visible around the site, note their approximate location 
on your site sketch. As artefacts can be moved by natural and cultural activity, the location 
and distribution of artefacts indicate site formation processes occurring on site)

8.1.2. Site Sketch Sheet

Data to be Collected Metadata Description

Site Sketch 1 – Key Sheet The site sketch sheet is a key visual aid for any other diver to replicate your survey. Draw 
a sketch of your site and number up to 10 locations where you will do longitudinal survey. 
In the key features box write a short description of each location (i.e. anchor, engine or 
boiler..). Attach the site sketch in the survey reporting page as either a PDF or high-resolu-
tion JPEG document.

(Labelling files prior to entering results into the website: Date (yyyymmdd format) under-
score site name underscore template sheet details i.e. 20180728_ Star of Greece_sites-
ketch 

Site Sketch – Working Copy 
Sheets (NB: Members can 

attach up to five PDFS in this 
section of the survey report. 

Each PDF can have more than 
one page if required)

To avoid a cluttered site sketch which is too busy with
information you have collected, it is better and easier to make a
second or more sketch of your site and add other details to those site sketches. Attach 
PDF or high-resolution JPEG. 

(Labelling files prior to entering results into the website: Date (yyyymmdd format) under-
score site name underscore template sheet details i.e. 20180728_ Star of Greece_sites-
ketch2 

8.1.3. Photo Condition Sheet

Data to be Collected Metadata Description

Site – Name and year of 
sinking

i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their 
registered or historically correct name)

Location (Latitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Location (Longitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Datum i.e. WGS84 datum

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Date of Survey Format yyyymmdd (i.e. 20180728)

Site Sketch Grid no. Select a letter: A - N and a number: 1 - 13

Feature/Location Number of Survey Point taken from Site Sketch (i.e. SP 1-10)

Time photos were taken Format 00:00 24 hour

Depth of diver observation 000.0 meters. The relationship of the diver taking the image to the object is captured here 
to assist future photographers to be in the same space facing in the same direction
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Data to be Collected Metadata Description

Direction photo taken i.e. 60 (E – NE)

Number of photos taken This is to indicate if there are other photos that may be accessed later, if required. Person-
ally, I always take more than one photo so I can choose the best image. Between survey 
points I take a photo of my hand between survey points so when I am reviewing images of 
a survey I can easily differentiate between photo sequences

Observation of exposed 
artefacts physical condition, 

biological growth and 
sediment cover

Max. 500 characters

Attach best condition image*

(*Up to 10 records can be 
entered)

Attach PDF, JPEG or high-resolution TIFF. Label condition images of features. Date 
(yyyymmdd format) underscore site name underscore template sheet details. i.e. 
20180728_ Yongala_sp1_image1 
[sp1 = Survey Point (and number allocated from 1 – 10)]

8.1.4. Photogrammetry Sheet

Photogrammetry (annotate the site sketch)

Unique scale number or 
description of scale

Describe the scale (i.e. 1m white, 0.5m white and black and 1m orange)

Depth of scale Regardless of the controls or scales used it is important to record the depth of each con-
trol point/photogrammetry target to help you scale the site in space (X, Y and Z)

Location of scale 
(i.e. Site sketch grid number)

Indicate the approximate location of each unique scale and its depth on a site sketch

Description of location being 
imaged and relevant survey 
point number if applicable

This is to indicate if there are other photos that may be accessed later if required

8.1.5. Site and Conservation Data Sheet

Data to be Collected Metadata Description

Site – Name and year of 
sinking

i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their 
registered or historically correct name)

Location (Latitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Location (Longitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Datum i.e. WGS84 datum

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Date of Survey Format yyyymmdd (i.e. 20180728)

Time of Survey Format 00:00 24 hour

Water temperature at surface (usually +/-0.1 in degree Celsius)

Visibility in water Select one: <5m, 5-10m, >10m (Through water visibility)

Current on site (direction) Record compass direction i.e. Easterly current. (NB. The direction of ocean currents is the 
direction they’re headed for or where the current is flowing towards, and the direction of 
wind is named as the direction from where it’s blowing. So an easterly current and westerly 
wind is going the same way or has the same vector - from west to east)

Current on site (speed) i.e 0.5 knots

GIRT Scientific Divers Guidance Document 8. Metadata Guidance



34 35

Data to be Collected Metadata Description

Site Orientation Select one: Upright, upside down, lying on port side, lying on starboard side, listing to port, 
listing to starboard

Site compass direction of 
wreck (stern to bow)

Use 000 degrees and 16 point compass term (i.e. 90 degrees E) (gives approximate 
direction of travel)

Evidence of structural 
collapse

Select one: Yes or No

Evidence of structural 
collapse - image and depth

If yes, Depth is recorded in meters (00.0)

Evidence of structural 
collapse - image

Photograph and indicate where on the site sketch. This informs the site classification 
question on the surface data sheet Attach PDF, JPEG or high-resolution TIFF. Label 
condition images of features. Date (yyyymmdd format) underscore site name underscore 
template sheet details. i.e. 20180728_ Yongala_sp1_image1 [sp1= Survey Point (and 
number allocated from 1 – 10)]

Composition of dominant 
wreck material visible

Select one: Iron, aluminium, wood/timber. (If other than these materials please list under 
other)

Location deepest point 
on wreck

Short description - 100 characters. Mark location on site sketch

Depth at deepest point on 
wreck

Maximum depth is recorded at the deepest point on the site. Depth is recorded in meters 
(00.0) (To be determined by you with reference to depth gauge (typically depth gauges 
have a +/- 0.1m 
accuracy). Place hand with depth gauge on top of identified location)

Water temperature at deepest 
point on wreck

Degrees Celsius (usually +/-0.10C error in dive computers)

Site Dimensions - length In meters. To be used to calculate area: (Length (m)) x (Width (m)) = Area in m squared

Site Dimensions - width In meters. To be used to calculate area: (Length (m)) x (Width (m)) = Area in m squared

Mobility of Sediment Surface 
(rippling, direction)

Take a compass bearing on the direction of travel of ripples use 000 degrees and 16-point 
compass term (i.e. 90 degrees E). To assist calculating the frequency of a repeating event - 
determine the number of times that event occurs within a specific period, then dividing the 
count 30. For example, if 15 events occur within 30 m the frequency = 15/30 = 0.5 ripples 
per meter. To assist in determining this lay down the 30m tape measure and count the 
number of ripples over that distance

General Seabed Topography 
near site

Select one: Flat, crest, slope

Sediment Colour Gradation 
(changes in colour over the 

area of the site)

Select one: Yes or No. (Changing colour of sand over the site may indicate different 
conditions for preservation or recent scouring or deposition)

Sediment Colour Gradation 
(changes in colour over the 

area of the site)

Select one: Yes or No. (Changing colour of sand over the site may indicate different 
conditions for preservation or recent scouring or deposition)

Sediment Colour Gradation
- image

Photograph with scale and indicate where on the site sketch. This informs the site 
classification question on the surface data sheet Attach PDF, JPEG or high-resolution TIFF. 
Label condition images of features. Date (yyyymmdd format) underscore site name_ 
underscore template sheet details. i.e. 20180728_Yongala_sp1_image2;	
[sp1= Survey Point (and number allocated from 1 – 10)]

Sediment Slope near wreck 
(gradient)

Select one: Flat, slight incline, steep incline. (Swim length of site noting depth change from 
bow to stern, 1-2m flat, 2 - 4 meters slight incline, > 5 steep incline)
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Data to be Collected Metadata Description

General composition 
seafloor (coral, limestone 

outcroppings, sand, boulders, 
pebbles, clay, seaweed, 

seagrass)

Select relevant: Coral, Limestone outcroppings, Sand, Pebbles, Boulders, Clay, Seaweed, 
Seagrass. (The preservation ability of sediment in the marine environment is linked to 
the size of the sand grains (larger particles allow more oxygen access into the sediment 
column), the amount of organic detritus included within the sediment column and the rate 
and extent of the physical agitation of the deposit.
Lighter coloured and red/brown sands (containing iron ions) are typically oxygenated and 
include sessile marine organisms (bryozoans, sponges, ascidians and tunicates and marine 
borers (molluscs or crustaceans). Black sand is usually anaerobic (no oxygen) where 
sulphate reducing bacteria predominate as the mechanism for deterioration. These sands 
help preserve shipwrecks by significantly changing the rate of deterioration. Sand can 
range from very coarse (1.0 -2.0 mm) per grain, through medium sand ¼ - ½ mm to silt < 
1/16 mm. Pebbles are approximately 4- 64 mm each, cobbles 64 -256 mm and boulders 
> 256 mm. Underwater it is impossible to gauge this by eye and sampling does not align 
with GIRT’s ‘no impact’ research approach. Members are asked to assess by eye whether 
the sediment over the site comprises of Coral, limestone outcroppings, boulders, cobbles, 
pebbles, sand, silt. More than one can be chosen and an approximate proportion can be 
indicated for each.)

Vegetation cover on seafloor Select one: 0-20%, 21- 40%, 41 -60%, 61 - 80%, 81-100%

Percentage of concretion 
(fouling organisms) coverage 

on exposed wreck material

Of the visible portions of the wreck, approximately how much of the exposed material is 
covered in concretion or other marine growth. Give results as a percentage, i.e. 70%

Evidence of recent active 
corrosion

Select one: Yes or No. (Corrosion is indicated by the appearance of red active areas on iron. 
Sometimes gas can be evolving from cracks in concretion).

Evidence of recent active 
corrosion - depth

If yes, Depth is recorded in meters (00.0)

Evidence of active corrosion 
- image

Photograph with scale and indicate where the most active corrosion is occurring on the 
site sketch. Attach JPEG or high resolution TIFF. Label condition images of features. Date 
(yyyymmdd format) 
underscore divers name underscore divers name underscore AUCHD Shipwreck ID number 
for your site underscore template sheet details. i.e.
20180728-_ viduka_bullers _5748_4sp1_image1 
20180728_viduka_bullers_5748_4sp1_image2; 
20180728_ viduka_bullers _5748_4sp2_image1
[sp1 = Survey Point (and number allocated from 1 – 10)]

Evidence of seasonal or 
storm/cyclone exposure

Select one: Yes or No

Types of fouling organisms 
on wreck

Select one: Yes or No. (NB: fouling organisms are animal or plants attached to surface of 
the site)

Types of fouling organisms on 
wreck - image

Take a photo of the dominant looking type of marine fouling organisms. Label and attach 
up to 10 images with scale.
Attach JPEG or high resolution TIFF. Label condition images of features.Date (yyyymmdd 
format) underscore divers name underscore divers name underscore AUCHD Shipwreck 
ID number for your site underscore template sheet details. i.e. 20180728_ viduka_
bullers_5748_4sp1_image1; 
20180728_viduka_bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_
image1	 [sp1 = Survey Point (and number allocated from 1 – 10)]

Evidence of timber Infestation 
by marine borers

Select one: Yes or No

Evidence of timber Infestation 
by marine borers - image

Photograph with scale and indicate where the most active marine borer activity is 
occurring on the site sketch. Attach JPEG or high-resolution TIFF. Label condition 
images of features. Date (yyyymmdd format) underscore divers name underscore divers 
name underscore AUCHD Shipwreck ID number for your site underscore template 
sheet details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_
bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1 = 
Survey Point (and number allocated from 1 – 10)]

Is contemporary rubbish 
present around the site (Yes, 
No) Indicate on site sketch 

where image/s taken

Select one: Yes or No. Indicate on site sketch

Is contemporary rubbish 
present around the site

Select relevant: Beer cans, glass bottles, fish nets, fishing line, tyres, plastic, rope, other 
(100 characters to type in what other is)
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Data to be Collected Metadata Description

Approximate no. of pieces of 
rubbish around site

Select one: 0-20, 21-40,41-60,61-80,81-100, >100

Evidence of Human 
Disturbance

Select one: Yes or No. (If yes option to add more than one record) Indicate on site sketch

Evidence of Human 
Disturbance - description

Select relevant: Anchor damage, digging, objects moved, broken timbers, exposed 
artefacts, other (100 characters to type in what Other is)

Evidence of Human 
Disturbance - depth

If yes, Depth is recorded in meters (00.0)

Evidence of Human 
Disturbance - image

Photograph with scale and indicate where the evidence of human disturbance occurred 
on the site sketch. Attach JPEG or high resolution TIFF. Label condition images of 
features. Date (yyyymmdd format) underscore divers name underscore divers name 
underscore AUCHD Shipwreck ID number for your site underscore template sheet 
details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_
bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1 = 
Survey Point (and number allocated from 1 – 10)]

Sediment build up on site or 
around features

Select one: Yes or No. Indicate on site sketch

Sediment build up on site or 
around features - depth

If yes, Depth is recorded in meters (00.0)

Sediment build up on site or 
around features - image

Photograph with scale and indicate where the evidence of sediment build up occurred 
on the site sketch. Attach JPEG or high resolution TIFF. Label condition images of 
features. Date (yyyymmdd format) underscore divers name underscore divers name 
underscore AUCHD Shipwreck ID number for your site underscore template sheet 
details. i.e. 20180728_ viduka_bullers _5748_4sp1_image1 ; 20180728_viduka_
bullers_5748_4sp1_image2; 20180728_ viduka_bullers _5748_4sp2_image1	[sp1 = 
Survey Point (and number allocated from 1 – 10)]

Location highest point on 
wreck

Short description - 100 characters. Mark location on site sketch. Minimum depth is 
recorded at the shallowest point on the site. Depth is recorded in meters (00.0) (To be 
determined by you with reference to depth gauge (typically depth gauges have a +/- 0.1m 
accuracy). Place hand with depth gauge on top of identified location)

Depth highest point on wreck Depth is recorded in meters (00.0). Minimum depth is recorded at the point on the site/
wreck closest to the surface

Temperature highest point 
on wreck

Degrees Celsius (usually +/-0.10C error in dive computers)

Materials Select one: Metal, Ceramic, Glass, Stone, Rope, Timber, Leather, Textile, Skeletal, 
Unidentified

Object description Short description - 100 characters

Apparent Condition Select one: Very Poor, Poor, Fair, Good, Excellent

% Degree of Completeness Select one: 0-20, 21-40,41-60,61-80,81-100

Image Up to 10 images can be added in the survey report. Photograph with scale appropriate to 
object size. Attach JPEG. Label images immediately after fieldwork to ensure accurate post 
processing. Date (yyyymmdd format) underscore divers name underscore divers name 
underscore AUCHD Shipwreck ID number for your site underscore template sheet details. 
i.e. 20180728_ viduka_bullers
_5748_ExposedArtefact1_image1 ; 20180728_viduka_bullers_5748_ExposedArtefact1_
image2; 20180728_ viduka_bullers _5748_ExposedArtefact2_image1

Depth If yes, Depth is recorded in meters (00.0)

Location Short description - 100 characters. Mark location on site sketch

Time photo taken Record time in 24 hour clock 00.00 hours. Recorded to assist post fieldwork processing by 
correlating the written record with the date time stamp in the image metadata
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8.1.6. Video Transect Sheet

Data to be Collected Metadata Description

Site – Name and year of 
sinking

i.e. SS Yongala (1911) (Use name in AUCHD. Shipwrecks should be identified by their 
registered or historically correct name)

Location (Latitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Location (Longitude) In degrees decimal minutes (for GPS). NB: AUCHD uses decimal degrees e.g. Latitude – 
19.7654 Longitude -143.1234

Location (Datum) i.e. WGS84 datum

Divers name First name last name for each diver (i.e. Rick Bullers and Andy Viduka)

Date of survey Format yyyymmdd (i.e. 20180728)

Camera system and lens Free text field 100 characters

Video format MP4, MOV, WMV or AVI. (Circle one)

Time – length of recording Recorded in minutes and seconds (i.e. 1min 50sec)

Site Sketch Grid no. Select a letter: A - N and a number: 1 – 13 on the key Site Sketch sheet to indicate where 
point A of the video transect survey is located

Name/description of 
Location A

Free text field 100 characters

Depth at Location A 000.0 meters

Compass bearing from A to B i.e. 60 (E – NE)

Height of swim over from A 
to B

<1.0 m 1-2m, 3m, >3m (tick one)

Observation of exposed 
artefacts physical condition, 

biological growth and 
sediment cover

Max 500 characters

8.1.7. Other Marine Survey

Data to be Collected Metadata Description

What type of survey is this? Dropdown options (i.e. Reef Check, Red Map, Eyes on the Reef…..) which can be initially 
populated by administrator. Need to have a list that includes the chance for members to 
select ‘Other’ and add free text

Marine Survey Sheet 1*
(*Maximum of five PDFs or 
images can be loaded under 

this field)

Attach PDF, JPEG or high resolution TIFF (Labelling Marine
Survey PDFs - save file as: Date (yyyymmdd format) underscore divers name underscore 
divers name underscore AUCHD Shipwreck ID number for your site underscore template
sheet details i.e. 20180728_viduka_bullers_5748_MS_(name
of type of marine survey)
i.e.20180728_viduka_bullers_5748_MS_Reefwatch [Star of Greece is Shipwreck ID 
Number 5748 in the Australasian Underwater Cultural Heritage Database; 
[MS = Marine Survey. Reefwatch, Coral Watch, Redmap, Reef Check and Eye on the Reef])



8.2. THREAT AND RISK LEVEL

Data to be Collected Metadata Description

Identify the threat*
(*Up to 10 threats can be 

entered)

100 characters. (eg. The site been totally or partially exposed by a major weather event)

Identify the likelihood of the 
threat

Select one: 0-10%, 10-29%, 30-59%, 60-79%, 80-100%

Identify the threats 
consequence

Select one: minor, moderate, high, major, critical

Record the site’s Threat and 
Risk level based on the threat 

with the most significant 
consequence and highest 

likelihood to the site’s overall 
preservation

Select one: Low, Medium, High, Severe 
(NB. The selection of one of these variables 
changes the colour of the site on the 
ADOPT WRECK map page)
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TSS Wandra, Drum and Drumsticks, Jervis Bay Region, New South Wales Australia. 
GIRT survey 29 August 2020.
Photographer: Andrew Viduka.
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APPENDIX 1 - 3D PROCEDURES FROM 
IAN MCCANN – MAAWA MEMBER

 
A PRACTICAL APPROACH TO 3D PHOTOGRAMMETRY

The following techniques describe a low budget approach to 3D photogrammetry. This approach uses low cost 
or free software and rapid capture to produce a basic 3D model that is suitable for a simple site plan. Its simplicity 
and user friendly software means it can be used as a tool by most people, from the professional archaeologist to 
recreational divers. If the steps outlined are followed, models of high accuracy can be produced allowing precise 
measurements to be taken from them. Detailed site models and recordings of excavations are very important for 
post excavation study, and while currently this low cost approach will not replace traditional recording techniques, 
the rapid development of cameras, computers and programs means this may not be too far away.
An important facet of this technique is expectation, if you want a model with fine detail and all you have is; a single 
person, limited time and low end equipment, then you may well be disappointed.

So ask these questions: Why is the site being recorded? How is the model going to be used? What’s the budget? 
What level of skill is available?

If all that’s required is a rapid site survey for an initial assessment, then this approach will become an essential tool 
for maritime archaeology.

EQUIPMENT REQUIREMENTS: CAMERAS

Almost any camera will work, from a smartphone to a high end DSLR. What will vary is the quality of the 3D model 
produced from these different cameras. It’s not all about pixels, either: a 16 mega pixel smartphone, which has 
a small sensor, will not produce as good a picture as one taken by a 16 mega pixel camera with a large sensor. 
Putting more pixels on a small sensor doesn’t improve pixel resolution. As shown in the image to the right, the 
‘full frame’ sensor has larger pixels than the others. The larger the pixel the more light is collected, and therefore 
produces a picture with superior dynamic range and less noise. 

This is a bit of over simplification, there are a lot more factors involved with 
image quality but it’s one of the most misunderstood aspects of digital 
cameras. Video can also be used from which screen grabs or captured 
images can be generated, this data will produce acceptable models. 
GoPros have been particularly successful due to their ease of use, good 
depth of field and acceptable quality. Extracting data from video using 
Photoshop is shown further on in this procedure. Using a GoPro won’t give 
a detailed model, but it will produce a basic model suitable for an initial site 
assessment.

Using a camera underwater (unless waterproof) necessitates the use of an 
underwater housing which can cost more than the camera. However, there 
are a number of more affordable alternatives available that can be just as 
effective. I’ve been using a cheap housing for a Sony Nex camera for over 
three years to 40m with no leaks. Just remember: buyer beware.

Settings for the Camera

Shutter speed: A fast shutter speed is necessary to produce sharp images. When taking a photo, it’s important 
to be as still as possible. However underwater this is more challenging, and a faster shutter speed will help 
compensate for any motion and minimize blur. This is desirable as motion blur reduces the amount of recognizable 
data for the program to analyse, and can result in a poor model.

Aperture: Depth of Field describes the portion of the image in focus, and therefor it’s ideal to get the greatest 
depth of field possible. F22 will give a better depth of field than F4.5. However, as long as the area you want to 
capture in that frame is in focus, then other frames can fill in the blurred data during processing.
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ISO: With modern cameras the ISO can be pushed beyond 100,000. Doing so means a higher quality photograph 
in lower light conditions can be captured because a faster shutter speed and a higher aperture can be used.

Lenses: The better the lens optics the better the level of detail, which translates into better data for the software to 
process and fewer number of images that need to be taken overall.

Ultra-wide angle lenses cause more distortion in the image and this can cause problems in processing, however 
consistently good results can be obtained with wide angle lenses of 15mm and greater, with very good pair 
matching in processing. The advantage of the wide angle lens for the diver is that you can get closer to the subject, 
which results in fewer particles or backscatter in the picture, and can therefore produce better photographs.

Quality: This really comes down to the processing speed of your computer and the graphics card. It’s best to 
capture the highest quality image your camera can manage, as the size or resolution can always be changed later 
in a batch editing package, such as IM Batch (www.highmotionsoftware.com/products/imbatch).

Your computer may not be able to handle a large number of high quality images which may mean slow, or no, 
processing. Getting the best quality data also future proofs your work. As computers get faster and software 
more sophisticated, processing these high quality images in the future will become more manageable. Photoscan 
recommends 5mp and upwards to get good consistent results.

Editing Images

If the information in this procedure is followed this step shouldn’t be needed. If editing is required then using 
the auto button on most packages will improve the photographs. If you are having trouble with the photographs 
aligning then adjusting the contrast can help.

Additional Light Sources

In a studio or controlled environment extra light sources may be manageable. Softboxes, reflectors or just 
bouncing light off the walls or ceilings can give an even spread of light. However without a bit of experience, the 
use of an additional light source in 3D photogrammetry will cause problems, the main one being an increase in 
shadows (also called caustics). Shadows will create blank spaces in the models because detail is hidden by these 
shadows.

Software

There are currently over forty software packages available for 3D photogrammetry ranging from Autodesk 123D 
Catch, a free phone App, www.123dapp.com/catch, through to Simactives Correlator3D designed to process 
satellite data. For this introduction to photogrammetry we’ll be using Agisoft Photoscan it has almost become the 
default programme for this technique due to its user-friendly workflow. Photoscan’s workflow is basically acquiring 
images, feature extraction, 3D surface generation, and texturing.

If you don’t have access to Agisoft Photoscan, either the standard or professional edition, then you can download 
a trial license for 30 days, http://www.agisoft.com/downloads/request-trial/. The trial will let you try everything 
except exporting and saving your model. The requirements to run this programme are:

Minimum Configuration

•	 Windows XP or later (32 or 64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)
•	 Intel Core 2 Duo processor or equivalent
•	 2GB of RAM

Recommended configuration

•	 Windows XP or later (64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit)
•	 Intel Core i7 processor
•	 12GB of RAM

At 10 MP per photo, 2GB RAM is sufficient to make a model based on 30 photos, 12GB RAM will process up to 300 
photographs per model.
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The practical outlined later will only take you up to producing a 3D model on your screen as you can’t export or 
save the model with the trial license.

The free program Meshlab is needed to scale the model if the standard version of Photoscan is being used.
https://sourceforge.net/projects/meshlab/files/meshlab/MeshLab%20v1.3.3/.

Underwater

Many of the unique challenges posed by taking photographs or video underwater can be addressed by good dive 
planning and preparation. A site visit or using online resources prior to a recoding run can be valuable. It’ll inform 
as to the nature of the site; in terms of depth, currents, tides, visibility, access/egress, and potential complications.

For example if the site is in shallow water then SCUBA may not be needed but the snorkelers may be exposed 
to increased water movement from tides, current, wind or swell. Shallow water sites, less than 3 metres, can 
have lighting problems due to wavelets causing light to be refracted through the surface of the water so that it 
illuminates the target with a constantly changing light pattern.

If these conditions are encountered then shoot early in the morning or late afternoon.

The size and complexity of the site will dictate the patterns of the recording runs and how many additional sections 
will need more detailed recording. If the vessel has collapsed and has a fairly low profile then, the recoding runs 
are fairly straightforward. If there are elevated features, such as engines, deck winches, a wheel-house or even 
anchors then separate recording runs will be needed and these processed with the main body of data. Wrecks 
with fairly intact hulls may need multiple recording runs at different times of the day when the natural light will 
illuminate different parts of the wreck, this will help reduce shadows which hide data. If there isn’t sufficient overlap 
of photos or the pattern is too simple, areas hidden by shadow or parts of the wreckage will result in voids in the 
model. In the figure below diver 1 will miss areas obscured by some of the wreckage (the red shaded section), with 
a second run diver 2, with the recommended overlap, will help cover most potential voids.
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The diagram below is a suggested pattern to swim for capturing photos on wrecks, overlaying two swimming 
patterns will help capture areas that may be hidden by the wreckage it’s self.

Additional light sources can reduce or eliminate shadows but if not used correctly it can increase them. They can 
also cause backscatter, this is where the light reflects off particles in the water between the object and the lens, 
again hiding detail.

Using a wide angled lens or getting closer to the target can help manage low visibility or lack of available light 
during a heavily overcast day, depth or particles in the water. This will also add to the number of photographs 
and commensurately increase the site recording time. The diver will also have to move slower and allow for more 
overlap.

On Land

Strong light, shadows and anything moving in the area being scanned can reduce the ability of the program to 
process the captured data. As with diving, choose the early morning or afternoon to capture data when the light 
can be more even. If shooting a small object outdoors, a shady spot is the best. If shooting indoors, choose a place 
away from any direct sunlight or widows, look for a position where the light is nice and even.

General Guidelines

Almost any camera can be used as long as the basic recommendation for capturing images is followed. When 
recording a site it’s important to keep the camera, lens, and settings the same. To speed up processing time the 
resolution of the camera can be set as low as 5MP.

Lenses between 15-20mm work well for larger sites whilst a 50mm lens will work for a single item like a small pot.

If using a Gopro for photographs or video the ultra-wide setting, 170 degrees, causes too much distortion in the 
image and results in having a greater number of rejected images in the photo alignment.

Images captured using ultra-wide lenses can be adjusted 
for lens distortion but this just means more work.

For still images, a Gopro can be set on the time-lapse mode 
and 0.5 seconds per frame, this works well most sites.

Record the images in a set pattern ensuring an overlap of 
50-75%, with a side overlap of 25- 50%. A feature that is 
recorded in multiple photo’s and can be identified by the 
software is essential for creating the geometry needed to 
create a 3D model.

If it’s a smaller target then get a few general shots of the 
item before shooting the closer ones for more detail.

The two figures opposite show a pattern used for a small pot. They indicate the camera position and angle. 
Starting with some general shots, to establish the form, move systematically around the pot allowing for the 
recommended overlap. This is repeated at different angles and heights until all details are captured.
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This pattern is also used to capture individual features on a larger target. If the pot had a larger belly or was a bowl 
with a wide, low flare then more images are needed at a lower angle to record all areas of the pot.

For larger sites a “lawn mowing” pattern is often the best as in the diagram below. The closer to the site you are, 
the more runs will be needed to get the overlaps.

If insufficient photographs are taken or not enough points matched in processing due to shadows, reflective 
surfaces or motion blur then voids or distortions in the model will be visible, as in the images below.
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Targets for Measurement

To enhance site recording beyond just a simple model for illustration, the use of scales for measurement is 
important. These may be anything of a known length, such as a scaling pole or simply a measurement between 
two significant fixed features on the site. Whatever is used should be of a non-reflective, matt surface and placed 
in a position where multiple photographs from different angles can ‘see’ them. Getting the correct orientation of the 
model can be made easier by the ensuring the scale is level by using simple bubble levels, see photograph below.

Recording

Once the best capture method has been determined, and a scale has been included, then the data capture can 
commence. Following the image capture pattern, moving or swimming as decided will ensure a full coverage of the 
site. It is important to be moving at a steady rate, allowing for the overlaps while not over-imaging one area.

When shooting directly down, plan, keep a 5-degree angle ‘up’ this can help produce better results.

Keep the same distance away from the subject, if it’s on a slope follow the contour down. For example, if a 
4-metre standoff from subject is being used try and maintain that at all times. For larger sites where most of the 
photographs are taken in plan, capture at least a couple of metres beyond its actual area. This will help in the 
processing, some models produce bends on their edges and these can be cropped if there are unwanted areas.

Once the “plan” run is done capture any features or parts of the site with any elevation. Try and get any overhangs 
or areas where data may be hidden and angle the camera so less of the unwanted background is captured.

The following exercises will break the process down into simple dot points and should produce suitable data for 
processing.

EXERCISE 1

Items Needed

•	 Small ceramic pot
•	 Piece of neutral coloured matt material 
•	 Scale
•	 Small table or stand
•	 A place with an even light 
•	 Camera

Method

Place the material on a small table or something to raise it up off the floor, preferably the cloth will cover the 
surface of the stand.
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Place the pot on the cloth and the scale close to its base.

Make sure you can walk around the pot and can keep a constant distance away from it. For a 30cm high pot try a 
45cm standoff. This distance will vary according to the shape and volume of the item, there’s no correct distance. 
Too close and the program can’t build a model, too far away and the detail will be poor. Trying to scan a variety of 
items to get experience at to what standoff is best for different items.

Use the auto setting on the camera.

Take four photographs from above the pot, plan shots, at even spaces whist moving around the pot. Remember to 
keep the camera steady when taking the photos.

On the next pass move down the pot, shoot the photos with the camera at approximately 30 degrees to the pot, 
taking around eight pictures at even spaces.

Move down again and have the camera at approximately 45 degrees, again taking eight photos.

Lastly move down again with the camera at 90 degrees to the pot and again take eight photos.

The data can now be processed.

The following screen captures show an image capture pattern used to record a 1 metre section of timber.
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EXERCISE 2

Items Needed

•	 Scale
•	 Camera

Method

Choose a larger feature, part of a garden for example.

Walk around it and work out how it can be recorded efficiently and methodically.

Place a scale.

Take several establishing shots so the program can make sense of what’s there. These should try and cover the 
whole area per shot and be taken from different angles.

Start from one point on the corner of the area to be recorded.

Take the photos with the camera at approximately 45 degrees to the ground.

Take the first photo, step forward and take the next.

Keep repeating this, possibly using the pattern shown below.

Once the plan shots are completed assess if there are any features that could be added.

Choose one and apply a capture pattern similar to the pattern used to capture the post in exercise 1. These Photos 
can be imported together by combining the files or as separate files or chunks.

Process the data.

GENERAL WORKFLOW

The general workflow for processing images is:

•	 Capture image / Stills / Process in Photoscan
•	 Capture image/ Video / Extract Stills / Process in Photoscan

Extracting Stills from Video

•	 Open Photoshop
•	 File > Open > Choose video file of subject > Open
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•	 File > Export > Render Video

•	 Render Video Box
•	 Name > Name your file
•	 Select Folder > Select folder destination Create New Subfolder> Do not tick Photoshop Image Sequence > 

JPEG
•	 Frame rate > Custom FPS > 5FPS
•	 Render
•	 The files will now export. Finally check the files have been exported.
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Processing the Data in Photoscan

PhotoScans workflow is very easy to follow. At each stage a dialogue box will open informing you of the progress 
of each step.

Add Photos or Files

Open Photoscan > File > New

Workflow > Add photos or add folder > Choose photo’s or folder’s > Open

The photos will now be loaded and will be referred to as a Chunk, visible on the left hand side of you screen. It will 
also show the number of cameras, each camera is a photograph.

Align Photos

Workflow > Align Photo’s > Accuracy: Medium > Pair Selection: Generic > OK

Pixels will now compared to find matches, work out camera location and produce a sparse point cloud. At this 
point the form of the item can often be recognized.

Build Dense Cloud

Workflow > Build Dense Cloud > Quality > Medium > OK

Significantly more points are produced to where the dense cloud appears as a solid model when zoomed out.

Build Mesh

Workflow > Build Mesh > Surface Type: Arbitrary > Source Data: Dense Cloud > Face Count: Medium

Faces are created over the model by connecting the points to make a continuous Mesh.

Build Texture

Workflow > Build Texture > Mapping Mode: Generic > Blending Mode: Mosaic (default) >Texture Size/Count: Use 
recommended, 4096 x 1 > OK

A texture map is wrapped around the model creating a photo realistic 3D model.

Orientation

When initially processed, the model is often upside down and needs to be correctly oriented.

To do this turn off the perspective view, this is shown in blue in the top left hand corner of the screen:
View > Perspective/Orthographic, select. The view you are now in will be shown in blue on the screen.

Next

View > Predefined Views > Top Select “Rotate Object” in the toolbar.

By using the cursor, highlighting one of the coloured bands on the sphere, red, green or blue, the ball the model 
can now be rotated in any direction. If the scale used for the model has been levelled, using simple bubble levels, 
the model can be orientated to that level.
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